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Chapter 1 - Introduction to the ISOMAP family
Introduction to the ISOMAP family
The ISOMAP family is an integrated software package that allows one to create a digital terrain model (DTM)
that can be used for further elaborations, such as rockfall analysis and groundwater modelling.
The ISOMAP module allows one to create a grid from a set of spot points, and to produce maps, wireframe
views, or solid views. It allows different calculations, such as slope mapping, exposure mapping, or filtering.

See Chapter 6 "Introduction to the ISOMAP module" for further information.
The INQIMAP module is dedicated to groundwater modelling. It leads to calculations from those based on
simple analytical solutions to those that incorporate advanced and complex numerical techniques.

See Chapter 14 "Introduction to the INQUIMAP module" for further information.
The ROTOMAP module is dedicated to 3D rockfall analysis, and allows the complete design of rockfall
protective systems. It features true 3D modelling and many other options for model calibration and barrier
design.
The "Introduction to the ROTOMAP module" and the subsequent chapters are not included in the present
version of the manual.
The ISOMAP family is a comprehensive package: it can directly produce high-quality graphic outputs, or export
them to DXF or EMF formats, which preserve the vectorial quality of the printouts, even when the files are
imported into external editors such as Microsoft Word or Corel Draw.
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Chapter 2 - System requirements and program
installation
System requirements
•

Pentium® class processor

•

Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

•

64 MB of RAM (128 MB recommended)

•

100 MB of available hard-disk space

•

CD-ROM drive

•

A printer driver must be installed, even if the printer itself is not connected to the PC.

Program Installation
To install ISOMAP and INQUIMAP run the inquimap32setup.exe installation package from the CD-ROM or
from the download directory.

Press the Setup button…
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…and select the directory to create the INQUIMAP32 folder.
Click the Continue button and the program program is automatically installed.
The first time you run the program the window that allows you to select your preferred language appears. Simply
click on the flag of the language you prefer.

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.
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Chapter 3 - The program protection
Hardware protection key
This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port
Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.
The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.
The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me
Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP
Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. install the package
3. browse the program directory,
HardKeyDrivers\Parallel_NT-2000-XP

and

run

the

program

SKEYADD.EXE

in

the

folder

SKEYRM.EXE

in

the

folder

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. browse the program directory,
HardKeyDrivers\Parallel_NT-2000-XP

and

run

the

program

3. restart the computer

Hardware protection key - USB port
Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP
All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
to load the driver from. To install the driver, follow this procedure:
1. start Windows, and login as Administrator (if necessary)
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2. install the package
3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT
Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. install the package
3. browse the program directory,
HardKeyDrivers\USB_NT4

and

run

the

program

SKEYUSBADD.EXE

in

the

folder

SKEYUSBRM.EXE

in

the

folder

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. browse the program directory,
HardKeyDrivers\USB_NT4
3. restart the computer

and

run

the

program
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Chapter 4 - Using the program in a local
network
Using the program in a local network
The programs can be used in a local network without moving the hardware key from one computer to another.
It is also possible to purchase multiple licenses to use the program on several computers at once.
USING THE PROGRAM IN A LOCAL NETWORK WITH A HARDWARE PROTECTION KEY
The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.
The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each
Client (in demo mode).
The program keyserver.exe should also be installed on the Server. The installation file of this program can be
found on the distribution CD-ROM, or on the Internet, at the URL:
http://www.geoandsoft.com/download/KeyServerSetup.exe
Run keyserver.exe and the hardware key management window appears.

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computer03\c\program files\inquimap32\inquimap32.exe). Now, with the
keyserver.exe program running, inquimap32.exe can also be run from the PC “computer03”.
NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.
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Chapter 5 - General information
Usage Notations
Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.
Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.
Words written in italics indicate a request for information.
CAPITAL letters are used to indicate computer, printer, directory, and file names.
Keyboard formats are used as follows:
•

KEY1+KEY2 - indicates press and hold down key1 and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the c key. The keys
are always indicated with capital letters.

•

key1,key2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the C key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface
User Interface and Data Entering
The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of frequently consulting the printed manuals.
All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.
The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).
Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus
The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.
The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.
To choose a command from a menu, use the following procedures:


Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.



Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.

The Graphical Output Preview Window
The Toolbar is located in the upper side of the preview window.
The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
the commands that belong to the Toolbar. The Toolbar displays the following commands:
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-



Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:
click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

-

Zoom - : click this icon to return to the original scale of the preview.

-

Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.

-

Print: click the print icon to send the drawing to the default printer.

-

Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

-

DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

-

EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

-

EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

-

Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows
The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.
When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.

Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.
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The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.
To scroll the list box and select an item, do as follows:


click the arrow, and then click the item to be selected.



press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.

Tere are three buttons in the dialogue window:
•

<Ok> - this button saves the entered information and goes on to the next phase.

•

<Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

•

<Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:


click the button



press ALT+UNDERLINED LETTER

To edit the data inside the dialogue window, use the following keys:
•

TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

•

ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

•

BACKSPACE

•

DEL

•

ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

•

UP ARROW/ DOWN ARROW

•

LEFT ARROW/ RIGHT ARROW

•

HOME

•

END

- cancels the last character that has been entered.

- cancels the character to the right of the cursor.

- these are used in multiple fields, or those fields that have a list box.
- moves the cursor to the previous or next field.

-moves the cursor to the beginning of the field.

- moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables
Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:
•

TAB

•

SHIFT+TAB

•

ENTER

•

PAGE UP

•

PAGE DOWN

•

UP ARROW

•

DOWN ARROW

•

- moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.
- moves the cursor to the previous button.

- moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.
- moves the cursor up 15 lines.
- moves the cursor forward 15 lines.

- moves the cursor to the input field directly above.

LEFT ARROW

- moves the cursor to the input field directly below.

/ RIGHT ARROW - moves the cursor to the field respectively to the left or to the right of the current

position.
•

HOME

- moves the cursor to the beginning of the line.
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•

END

•

F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press enter, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.

- moves the cursor to the end of the line.

The tables have two additional buttons:
•

<Insert> - creates an empty line before the one in which the cursor is positioned.

•

<Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:
The data entered in the table can be copied in order to be pasted into another table.
To copy the table’s contents:


press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.

To paste the Clipboard contents into the table:


press the key combination SHIFT+INS, or CTRL+V.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows
The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.
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Help On Line
A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:
1. Position the cursor on a field of a dialogue window and press F1.
2. Use the Summary from the Help menu.
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Chapter 6 - Introduction to the ISOMAP module
Introduction to the ISOMAP module
ISOMAP is the module that is used to calculate and render surfaces through contour lines or coloured and
shaded areas with a high degree of precision. The program allows the representation of the surface both in
topographic map and perspective view forms.
The calculation is performed in two stages. The first stage consists of creating a regular grid from a collection of
arbitrarily positioned points. The second stage consists of drawing the surface using the previously created grid.
The first stage can be performed using three methods: the inverse distance method, the kriging method, and a
new interpolation and extrapolation method based on a weighted average of polynomial surfaces.
The use of this polynomial algorithm makes it possible to generate points that are external to the area of the
sampled locations in such a way as to maintain the trend of the surface, even when this surface cannot be
approximated by a simple horizontal plane.
This feature is especially useful for those problems that deal with the surface gradient, such as flow line tracing
or rockfall analysis. The commonly used extrapolation algorithms based on the weighted average (including
kriging) can lead to large errors, for example to the inversion of the flow direction in the peripheral areas of the
map.
The use of a polynomial algorithm to create a grid also yields a more realistic surface of the area where the
sampled locations can be found, as the evaluation is less sensitive to the spatial distribution and point density.
The regular square grid is then interpolated with bi-cubic splines to obtain a continuous surface that is
continuously differentiable and which passes through the grid nodes.
The ISOMAP module has the following basic operations:
•

Grid Generation

•

Slope Map

•

Exposure Map

•

Grid Difference

•

Linear Transformation

•

Filtering

•

Grid Duplication

•

DTM Import

These operations are described later in this chapter.
If you are working with the ISOMAP-INQUIMAP package, the following operation is also available:
•

Finite Differences

•

Superimposition of Effects

•

Draw Isochrones

•

Calculation Concentration

Grid Generation (ISOMAP module)
The basis of any project is the generation of a regular grid. The square grid is generated using one of the
available methods, starting from a set of arbitrarily positioned points sampled on the surface under examination.
The more regular the disposition and density of the input points are, the more reliable the final result will be,
regardless of which calculation method is used. Let us consider the calculation methods that can be used.
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Weighted Average
The value for unsampled locations is equal to the weighted average of the values of the nearby samples. The
weighted average takes the following form:
n

n

i=1

i=1

Z'(p) = ∑ ( Z(i) * (1 / D(i, p) α )) / ∑ (1 / D(i, p) α )
where:
Z'(p) = estimated value at point p
Z(i) = sampled value at point i
D(i,p) = distance between point p and point i
alpha = weighting exponent
n = number of sampled points
This kind of interpolation is unbiased if the sum of the weights equals one. This is true for the inverse-distance
weighted method because the sum of the weights divided by the sum of the weights is equal to one.
The exponent on the distance function above can be altered. Altering the exponent on the distance affects the
relative weights of the points. In all cases, a sample that is further from the point to be estimated will receive a
lower weight.
As the exponent is increased, the relative influence of more distant points decreases.
A problem that exists with this method is that you have to make a guess at what the exponent should be, and
there is no assurance that your guess is correct.

Kriging
The Kriging algorithm, also called “best linear unbiased estimator”, was developed for mining geology. It is
“best” because it minimizes the error variance in the estimate, “unbiased” because the weights sum to one, and
“linear” because it is a simple weighted average. It also uses a weighted average method to calculate the value
at unsampled locations, but rather than guessing at the relationship between similarity of values and distance
(like we do when we guess at the exponent in inverse-distance methods), the relationship is calculated from the
data using the semivariogram.
Once the lognormal semivariogram has been calculated, the weights L(i) can be obtained to estimate the value
of an unsampled location. The Kriging takes the following form:
n

Z'(p) = ∑ ( Z(i) * L(i))
i=1

where:
Z'(p) = estimated value at point p
Z(i) = sampled value at point i
n = number of sampled points
This set of weights has the property

∑ L(i)

= 1

and guarantee the minimisation of the general expression that represents the variance of the error associated to
the estimate relative to point p.
n

n

2*

∑

( L(i) * G( D(i, p)) - g( D( p, p)) -

i=1

∑

∑ ∑ ( L(i) * L( j) * G( D(i, j))))
i=1 j=1
n

n

2*

n

(

( L(i) * G( D(i, p)) - g( D( p, p)) -

i=1

n

∑ ∑ ( L(i) * L( j) * G( D(i, j))))
(

i=1 j=1

where:
G(D(x,y)) = average variance associated to the distance between the points x and y
n = number of sampled points
This minimisation is obtained through the solution of a system of n+1 linear equations.

Method of the Weighted Average of Polynomial Surfaces
One of the greatest problems of the previously described methods is the impossibility of estimating values
outside the range defined by the maximum and minimum values of the sampled points. This problem has the
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immediate consequence of preventing one from extrapolating, in a significant way, the values beyond the area
that is actually covered by the sampled points.
Hydrogeology or rockfall analysis applications, based on the treatment of partial derivatives of the surface
(gradients), are in fact extremely sensitive to irregularities, even small ones, of the surface.
For this reason a more complex algorithm has been made available, that is based on an auxiliary polynomial
estimator Z"(i) which represents the regional trend of the variable under examination.
The estimate therefore assumes the following form:
n

n

i=1

i=1

Z'(p) = ∑ ( Z" (i) * (1 / D(i, p) α )) / ∑ (1 / D(i, p) α )
where:
Z'(p) = estimated value at point p
Z"(i) = estimated value in function of the value assumed at point i
D(i,p) = distance between point p and point i
alpha = weight exponent
n = number of sampled points

Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
- Select “Grid Generation” in the “Operation” window
- Use the “Edit Points” in the “Edit” menu to input the spot sampled points
- Use the “Grid Parameters” in the “Edit” menu to choose how the grid will be calculated
- Select “Calculation” on the menu bar

Slope Map (ISOMAP module)
With this command, the program creates a grid that contains the slope (in degrees) of a topographic surface.
It is possible to choose whether the program has to calculate the maximum or the average slope of the ground
around each node of the grid. As i , j are the grid node indexes and l is the mesh size, we obtain:
maximum slope =

max( z (i + 1, j ) − z (i, j ), z (i − 1, j ) − z (i, j )) 2 / l 2 + max( z (i, j + 1) − z (i, j ), z (i, j − 1) − z (i, j )) 2 / l 2
average slope =

( z (i + 1, j ) − z (i − 1, j )) 2 / 4l 2 + ( z (i, j + 1) − z (i, j − 1)) 2 / 4l 2
Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
- Select “Maximum Slope Map” or “Average Slope Map” in the “Operation” window
- Select the project that contains the original topographic surface
- Select “Calculation” on the menu bar

Exposure Map (ISOMAP module)
With this command, the program creates a grid that contains the angle from the North of the dip direction of the
ground. The Y-axis must be oriented to the North. The South direction will result to be equal to 180°; both the
East and West directions will be equal to 90°.

Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
- Select “Exposure Map” in the “Operation” window
- Select the project that contains the original topographic surface
- Select “Calculation” on the menu bar
Note: as an alternative, it is possible to obtain interesting results working on the original topographic surface
using a horizontal Light Vector.
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Grid Difference (ISOMAP module)
With this command, the program creates a new grid that is calculated as the node-by-node subtraction of two
given grids. A typical application could be the evaluation of the removed ground, which is obtained by
subtracting two grids that represent the topographic surface before and after an excavation.
It is mandatory that the two grids have the same number of rows and columns.

Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
- Select “Grid Difference” in the “Operation” window
- Select the project to extract from the “minuend” grid
- Select the “Select Subtrahend Grid” command from the “Edit” menu
- Choose an existing project (of the same grid size) to extract from the “subtrahend” grid
- Select “Calculation” on the menu bar

Linear Transformation (ISOMAP module)
The linear transformation operator makes it possible to perform a linear transformation of the surface,
performing the following three sequential operations for each node:
1. sums a first translation factor (a);
2. multiplicates by a scale factor (b);
3. sums a second translation factor (c).
The general formula z'=(z+a)*b+c makes it possible to perform any linear transformation such as the CelsiusFahrenheit conversion, with a=0, b=9/5 and c=32.

Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
- Select “Linear Transformation” in the “Operation” window
- Select the project to be transformed
- Select the “Linear Transformation Parameters” command from the “Edit” menu
- Select “Calculation” on the menu bar

Filtering (ISOMAP module)
This operator performs a numerical filtering in the space domain, that is to say, the convolution of a matrix
operator of order 2n+1 with the grid itself.
The filters should always be symmetrical to the axis that passes through its centre, and to the two diagonals.
By using a unit matrix one will obtain a grid that is the moving average of the original grid. By using this
command in conjunction with the Grid Difference operation, one can, for example, separate the local gravity
anomalies from the regional ones.

Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
- Select “Filtering” in the “Operation” window
- Select the project to be filtered
- Select the “Select Filter” command from the “Edit” menu
- Choose a filter (you can create a new one with a text editor)
- Select “Calculation” on the menu bar

Grid Duplication (ISOMAP module)
This command enables one to duplicate a project, for example to allow parametric analyses.
It can also be used to create a new grid from an existing one, changing the extension of the grid and the size of
the mesh.

Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
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- Select “Grid Duplication” in the “Operation” window
- Select the project to be duplicated
- Assign the new values of Xmin, Xmax, Ymin, Ymax and of the Mesh Size
- Select “Calculation” on the menu bar
Note: the X,Y values must be inside the ranges of the original grid.

DTM Import (ISOMAP module)
With this command, it is possible to import regular grid data from other programs and convert these into the
ISOMAP format. A default ISOMAP format can be used, or a custom made filter can be developed on request.
The data files must previously have been created, with a text editor such as Notepad, and have the “.ZRE”
extension.
The structure of the ZRE files is quite simple: on the first line write the number of nodes on the X-axis, on the
second line write the number of nodes on the Y-axis, on the third line write the mesh size (in metres) between
two nodes, in the two next lines write the abscissa and ordinate of the first grid node in the bottom left corner.
The file can now be completed with the Z-values, column by column (left to right), each column in a bottom-up
order. Each column of Z-values must be preceded by a line that contains the text “Column #”, where # is the
column number. Once the file is saved, the import procedure can be started.

Procedure
- Select the “New Project” command from the “Project” menu
- Choose a new name for the project
- Select “Import ZRE file” in the “Operation” window
- Choose the ZRE file you want to import the grid from
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Chapter 7 - ISOMAP family - General
Commands
Project Menu (ALT,R)
This menu contains all the commands that are used to open and delete the files which contain all the project
data. As long as the project name has not been defined, the other menu items are disabled.

The last opened projects are shown in the lower part of this menu.

New Project Command (ALT,R,N)
In order to operate with this program, it is necessary to open a project; this can be a new project or an already
existing one. To open a new file:



choose the New Project command from the menu by first clicking the Project menu item and then on
the New Project command. Type the name of the new file in the File Name field and confirm.



choose the New Project command from the menu by using the combination of the keys ALT,R,N. Type
the name of the new file in the File Name field and press ENTER.

The name of the file in use will be reported in the title bar of the main window.
The name of the file should not contain spaces and/or punctuation marks. It is not necessary to indicate any
extension, since the extension “.NFJ” is automatically added: for example, given the name “TEST01”, the file
name “TEST01.NFJ" will be internally used by the program.
When opening a new project, it is necessary to choose which operation has to be performed. Only one
operation can be associated to each project name, and it cannot be changed later on.
It is possible to create a series of projects, each of which uses the results of a previously elaborated project as a
“starting point”: this will be the Source Project.
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See chapter 6 "Introduction to the ISOMAP module" for information about the Grid Generation, Slope Map,
Exposure Map, Grid Difference, Linear Transformation, Filtering, Grid Duplication and DTM Import operations.
There is no specific command In the program to save data, as these are automatically saved after each data
entry or elaboration.

Open Project Command (ALT,R,O)
In order to operate with this program, it is necessary to open a project; this can be a new project or an already
existing one. To open an existing file:



choose the Open Project command from the menu by first clicking the Project menu item and then on
the Open Project command from the menu. Type or double click the name of the new file in the File
Name field and confirm.



choose the Open Project command from the menu by using the combination of the keys ALT,R,O. Type
the name of the file in the File Name field then press ENTER. Otherwise press TAB and then the UP
ARROW or DOWN ARROW to select the name from the list, then press ENTER.

The name of the file in use will be reported in the title bar of the main window.
There is no specific command In the program to save data, as these are automatically saved after each data
entry or elaboration.
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Delete Project Command (ALT,R,D)
This makes it possible to delete all the files pertaining to a project. Before using this command, one should be
sure that these data are no longer necessary. Particular care must be taken if the project has been used as a
Source Project for other elaborations. Before deleting the files, the program asks for confirmation.

Printer Setup Command (ALT,R,P)
When selecting this command, one calls the printer configuration dialogue window. Here one can verify and
modify the default printer setup or select another printer from the list of the installed ones.

Print Menu (ALT,P)
The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.

Parameters Command (ALT,P,P)
With this command, the “Graphical Parameters” dialogue window is shown.

The “Graphical Parameters” Dialogue Box
The " Graphical Parameters" dialogue window allows the configuration of most of the graphical parameters (see
also the “Configure” item of the Print menu).
•

Map, Wireframe View, Solid View: one can here choose the representation type.

The three buttons on this dialogue window allow one to select different parameter sets.
<Geometric Parameters> Button
•

Scale: this is the scale factor that has to be used in the graphical output. It is the denominator in the fraction
1:scale

•

Labeled contour lines interval: this is the elevation difference between two labeled contour lines. One ought
to remember that the number of lines is inversely proportional to the given interval. A too small interval will
slow down the drawing speed.

•

Unlabeled contour lines interval: this is the elevation difference between adjacent unlabeled contour lines.
One ought to remember that the number of lines is inversely proportional to the given interval. A too small
interval will slow down the drawing speed.

•

Smooth factor: this is the number of elements into which each grid element is divided, in order to represent
more detailed contour lines; the larger this number the more accurate and attractive the drawing will be. If a
high value is used there will consequently be a longer computing time and a larger file size, which increase
proportionally with the square of the Smooth factor. If the Smooth factor is equal to one, a special faster
algorithm is used. The Smooth factor value can vary between one and nine.

•

Minimum Z coordinate: this defines the minimum threshold value of the contour lines that have to be
represented. This parameter can be useful, for example, when plotting concentration contour lines where it
would be erroneus to represent negative values. The range between minimum and maximum is an open
interval.
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•

Maximum Z coordinate this defines the maximum threshold value of the contour lines that have to be
represented. This parameter can be useful when one wants to eliminate values that are too high, such as
the borders of polynomial extrapolations.

•

Zero range to hide: this parameter allows one to hide the contour lines close to zero. This option is useful,
for example, for the representation of magnetometric data.

•

Vertical exaggeration factor: this factor enables one to stress the drawing, thus enhancing the anomalies of
the plotted quantity.

•

Viewpoint distance: this is only used in the Solid View. It is the absolute distance (in meters) between the
viewpoint and the centre of the grid. This parameter is not used in the Wireframe View, because, in this
case, the viewpoint distance is considered to be infinite.

•

Viewpoint Vector X , Y, Z components: these define the direction of the viewpoint from the centre of the grid.
The program disregards the vector magnitude, and automatically considers only the direction. It is used both
in the Solid View and in the Wireframe View.

•

Light Vector X , Y, Z components: these define the direction of the light point from the centre of the grid. If
the three coordinates are equal to zero, no light effect is added. These parameters are used in the Map and
in the Solid View.

•

Sampled locations: one can decide if and how the sampled locations will be drawn. The available options
are: a simple cross, a cross labeled with the value of the sample, a cross labeled with the name of the
location, or no representation at all.

<Vectors and Titles> Button
•

Flow vectors: with this option it is possible to draw flow vectors as small arrows positioned on the grid
nodes. There are three options: Direction - unit vectors are drawn, oriented towards the dip direction;
Velocity - the velocity vectors are drawn, as defined in Darcy’s law, with the lengths proportional to the
product of the hydraulic head gradient and the hydraulic conductivity; Gradient - flow vectors are shown as
arrows oriented towards the dip direction: the vector length is proportional to the dip of the surface. No
vector is drawn with the No Vector option.

•

Vector step: this is used to space the vectors further apart; when assigning a value equal to 3, a vector, for
example, will be drawn every three grid nodes.

•

Vector length / mesh width ratio: the maximum (or unit) length of the vectors is, by default, equal to the
mesh width. It is possible to to alter this value by assigning a vector length / mesh width ratio that is different
from one.

•

Lines: this is used to draw a set of continuous flow lines. The required data are: the X,Y coordinates of the
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end points of an imaginary segment, and the number of equally spaced points along this segment through
which the flow lines will pass.
•

Titles: entering a title or sub-titles is not mandatory.

•

Legend Caption: when a Map or a Solid View is coloured, a legend is automatically added. It is possible to
add a caption to describe the plotted quantity.

•

Legend check box: unchecking this box, the legend will not be plotted; this option is useful to export a
“clean” graphic output to other programs like GIS.

<Colour Selection> Button
•

Number of colours lower than: the program automatically detects the optimal contour line intervals, using
n
n
n
multiples of 1.0E , 2.0E and 5.0E . Setting the Number of colours lower than parameter, the program is
forced to choose a value of the contour line interval that produces a number of contour lines (and colour
ranges) lower than the given value.

•

“Reset intervals” button: this button activates a procedure that recalculates the contour line intervals as a
function of the previous parameter.

•

Scale type: the colour shade distribution can be organised using different scale types: linear, inverse linear,
logarithmic, inverse logarithmic, quadratic or inverse quadratic.

•

Colour type: the colour sets can be generated in different ways: Black and White, Red, Green, Blue,
Multicolour, and Random. With the Black and White option one obtains a grey-scale output; With the Red,
Green or Blue option the selected colour shades towards white; the Multicolour options allows one to create
outputs using a continuous scale of colours, and the Random option assigns a colour that is randomly
chosen to each level.

•

Disable surface colouring: when this option is activated, the program does not colour the areas between the
contour lines.

•

R/G/B shade to black: with this option the selected colour will shade towards black instead of towards white.

•

Disable contour lines: when this option is activated, the program no longer draws the contour lines; if both
surface colouring and contour lines are disabled, nothing appears on the graphical output.

•

Remove violet from multicolour: this option allows one to start the multicolour scale (if selected) from the
blue instead of from the violet colour.

•

Use manual colour settings: one can choose to manually define the contour line values and the colours to fill
the area between the adjacent contour lines. To manually define those parameters, click the <Manual
Colour Setting> button.

•

The <Copy Colour Set> Button: If the current interval number is lower than 21, the "Manual Colour Setting"
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dialogue box is opened, and the current settings are copied and can then be modified, otherwise the button
is disabled.

The <Manual Colour Setting> Button
The <Manual Colour Setting> button opens the "Manual Colour Setting" dialogue box, where you can define the
contour line values and the colour one wishes to assign to each interval. These settings can be saved as
personalised colour profiles.
To change a colour, double click the coloured field and choose the new colour to be assigned to the interval
from the Colours Dialogue Box.
Each time a colour set has been defined and confirmed, it is saved as a default manual colour profile. It will then
be used each time the Use manual colour settings option is selected, if a different colour profile has not been
loaded or saved; in this case, the default colour profile is overwritten, and the selected (saved or loaded) colour
profile will be permanently associated to the current project, regardless of the default manual colour
configuration.
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•

<New Profile> button: if the current interval number is lower than 21, the current automatic settings are
copied and can then be modified, otherwise all the fields are cleared.

•

<Read Profile> button: the program reads a previously saved colour profile from the hard disk; this colour
profile will be permanently associated to the current project.

•

<Save Profile> button: this allows one to save the current colour profile on the hard disk; this colour profile
will be permanently associated to the current project.

Print Grid Command (ALT,P,G)
With this command, the Print Preview window is opened and the plot is shown; it is then possible to directly print
the graphical output, or export it to different formats.

Print Vertical Section Command (ALT,P,V)
With this command, a window is shown that allows the graphic output of a ground vertical section to be
configured.

The “Vertical Section Configuration” Dialogue box
A certain number of points along a given line are calculated and plotted as a vertical section. The required
parameters are:

•

Point Distance: distance between two adjacent calculated points along the given line [m].

•

Reference Elevation: elevation of the reference plane [m].

•

Horizontal Scale: horizontal scale of the graphical output.

•

Vertical Scale: vertical scale of the graphical output. The scales are separated to allow a vertical
exaggeration factor.

•

Abscissa, Ordinate: the X and Y planimetric coordinates of the nodes of the line, from the arbitrary origin
used to create the grid, along which the calculated points are aligned.

•

Ok Button: the print preview window is shown, and the vertical section is plotted.

•

Cancel Button: this is used to abort the current operation.

Export to Excel Command (ALT,P,X)
With this command, a window is shown to allow one to select which quantity has to be exported as an SLK file
(a format that is compatible with Microsoft Excel and other spreadsheets).
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Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.

One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a title only requires the colour and the character
font to be defined.
•

Click an object to select it (use the scroll bar to see the entire list)

•

Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

•

If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)

•

If the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

•

It is possible, as an option, to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.

Exit Menu (ALT,X)
This command allows one to exit the program. There is no specific command to save the entered data as these
are automatically saved each time they are modified.
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Chapter 8 - ISOMAP Menus - Grid Generation
Edit Menu (ALT,E) - Grid Generation
This menu is used to enter and edit the input data used in the gridding operations.

Data Points Command (ALT,E,P)
This enables one to enter and edit the input data points.

The “Data Points” Dialogue box
The following data should be entered in the “Data Points” window:
•

X and Y Coordinates: the planimetric coordinates should be entered (in metres) from an arbitrary origin.

•

Elevation: the ground elevation (or another physical quantity) that has to be represented on the Z-axis.

•

Name: this is an optional caption of the data points. There are two special characters that can be added at
the beginning of the point names (notice that those characters will not be printed on the graphical output):
when the point name begins with the @ character, the value will be used in the calculation but will not be
printed; when the point name begins with the # character, the data point will be printed (if one of the
Sampled locations options has been selected) but will not be used in the calculation.
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Gridding Parameters Command (ALT,E,G)
The Isomap module creates a regular grid that calculates the values of the physical quantity for each node of a
square mesh using different interpolation algorithms. The required parameters are entered in the Gridding
Parameters dialogue box.

The “Gridding Parameters” Dialogue Box
The following data are entered in the “Gridding Parameters”:

•

Calculation Algorithm: the calculation of the grid can be performed using the Kriging or the Weighted
Average of Polynomial Surfaces; a zero-order polynomial surface is a special case that corresponds to the
ordinary inverse-distance weighted average method.

•

Order of the polynomial surface: the basic concept of the Weighted Average of Polynomial Surfaces is that
the best fitting polynomial surface is calculated, as a first step, from the data points, then a gradual vertical
shift allows one to obtain a final surface that passes through the sampled locations. Going away from the
sampled points, the calculated surface converges to the best fitting polynomial surface. A zero-order
polynomial surface (Z = a) is a special case that corresponds to the classic inverse-distance weighted
average method. A fist-order polynomial surface (Z = a + b X + c Y) is a dipping plane that gives, for
example, a good approximation for a simple water table only sampled in three wells. The surfaces of the
second and third order are more complex and can better approximate a surface with many sampled
locations. These surfaces require a homogeneous distribution of the sampled points because the gradient of
the surface rapidly increases as it becomes distant from the sampled area.

•

Mesh size: the mesh size (in metres) should be such as not to exceed 500 grid elements along each X and
Y axe; if this value is exceeded, the mesh size is automatically adjusted.

•

Threshold distance: this is the radius (in metres) of the circle wherein the points that will be considered to
calculate a single grid value lie. As the used methods are based on an inverse-distance weighted average, it
could be a good idea to keep this value sufficiently large so as to consider all the sampled points in the
calculations, thus also obtaining a smoother surface with a small mesh size.

•

Weighting exponent: this is the exponent that is applied to the inverse distance which is used in the
weighted averages. The greater the exponent, the greater is the influence of a sampled point on the
calculated grid. This means that too small exponent values can generate a surface with “peaks” around
each sampled point, while too large exponent values can generate a “benched” surface. Values between 4
and 6 can normally yield good results.

•

Minimum X coordinate: together with the ordinate of the lower side, this defines the lower left corner of the
grid.

•

Maximum X coordinate: together with the ordinate of the upper side, this defines the upper right corner of
the grid.

•

Minimum Y coordinate: together with the abscissa of the left side, this defines the lower left corner of the
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grid.
•

Maximum Y coordinate: together with the abscissa of the right side, this defines the upper right corner of the
grid

Example
Example: an original surface, with data points regularly sampled on each grid node, has been made denser to
show the effect of the Weighting exponent. The best result has been obtained with Exponent = 3.

Original surface
Exponent = 3
Exponent values 1 and 2 produced a surface with “peaks” around each sampled point (particularly emphasised
with the minimum value); on the other hand, Exponent values 4 and 8 produced a “benched” surface
(particularly emphasised with the maximum value).

Exponent = 1

Exponent = 2

Exponent = 4

Exponent = 8

Hidden Mesh Selection Command (ALT,E,M)
This command allows one to hide some of the grid meshes. A graphical editing window is opened and the grid is
shown: by default, all the meshes are not hidden, and appear as green squares.
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The following procedure allows one to hide some meshes:
•

<Hidden>/<Shown>: select one of the two option buttons to choose whether to hide or show the meshes.
The hidden meshes will appear as red squares.

•

A single left-click assigns the currently selected status to a single grid mesh. Holding down the left button
and moving the mouse over the grid allows a continuous (multiple) selection of the meshes. Finally, a rightclick fills an area that is delimitated by a line of previously selected meshes.

•

<Cancel editing>: cancels the very last editing operation.

•

<Save>: saves the selection of hidden meshes.

•

<Cancel>: closes the window without saving any modifications.

Calculate Menu (ALT,C) - Grid Generation
With this menu, one can calculate the regular grid using the entered data points and the previously defined
parameters.
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Execute Calculation Command (ALT,C,E)
With this command, the program generates the grid. Use the print menu to view the results of the elaboration.
For more information see the Introduction tuo the ISOMAP module - Grid Generation

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface; enter the coordinates of the point
in the window and click the <Calculate> button.

The program calculates the required value using a bi-cubic splines interpolation algorithm, and displays the
result in the "Z" field.

Print Menu (ALT,P)
The Print menu is used to configure the graphical output and to plot the surface in Map, Wireframe View or Solid
View form.
For more information, see the "Print Menu - General commands"
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Chapter 9 - ISOMAP Menus - Slope Map
Edit menu (ALT,E) - Slope Map
With this command, the program creates a grid that contains the slope (in degrees) of a topographic surface.
When creating the new project, it is possible to choose whether the program has to calculate the maximum or
the average slope of the ground around each node of the grid.

Hidden Mesh Selection Command (ALT,E,M)
This command allows one to hide some of the grid meshes.
For more information, see the "Hidden Mesh Selection" - ISOMAP Menus - Grid Generation.

Calculate Menu (ALT,C) - Slope Map
This menu allows one to calculate a grid that contains the slope of a topographic surface (in degrees).

Execute Calculations Command (ALT,C,E)
This command allows one to calculate the slope of a topographic surface (in degrees).
Use the print menu to view the results of the elaboration.
For more information, see the Introduction to the ISOMAP module - Slope Map

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) - Slope Map
The Print menu is used to configure the graphical output and to plot the surface in Map, Wireframe View or Solid
View form.
For more information, see the "Print Menu - General commands"
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Chapter 10 - ISOMAP Menus - Exposure Map
Edit menu (ALT,E) - Exposure Map
With this command, the program creates a grid that contains the angle from the North of the dip direction of the
ground. The Y-axis must be oriented to the North. The South direction will result to be equal to 180°; both East
and West directions will be equal to 90°.

Hidden Mesh Selection Command (ALT,E,M)
This command allows one to hide some of the grid meshes.
For more information, see the "Hidden Mesh Selection" - ISOMAP Menus - Grid Generation.

Calculate Menu (ALT,C) - Exposure Map
This menu allows one to calculate the angle from the North of the ground dip direction.

Execute Calculations Command (ALT,C,E)
This command allows one to calculate the angle from the North of the ground dip direction.
For more information, see the "Exposure Map - Introduction to the ISOMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) - Exposure Map
The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.
For more information, see the "Print Menu - General commands"
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Chapter 11 - ISOMAP Menus - Grid Difference
Edit menu (ALT,E) - Grid Difference
With this command, the program creates a new grid that is calculated as the node-by-node subtraction of two
given grids. A typical application could be the evaluation of the removed ground, which is obtained by
subtracting two grids that represent the topographic surface before and after an excavation.
It is mandatory that the two grids have the same number of rows and columns.

Hidden Mesh Selection Command (ALT,E,M)
This command allows one to hide some of the grid meshes.
For more information, see the "Hidden Mesh Selection - ISOMAP Menus - Grid Generation"Select

Subtrahend Grid Command (ALT,E,G)
This command allows one to choose an existing project (of the same grid size) to extract from the “subtrahend”
grid

The “Select Subtrahend Grid” Dialogue Box
To select a file, type the name of the project to extract from the “subtrahend” grid in the File Name field, or
browse the hard disk and double-click the project file name.

Calculate Menu (ALT,C) - Grid Difference
Once selected the Subtrahend Grid, this menu allows one to calculate the grid difference as the node-by-node
subtraction of the two given grids.

Execute Calculations Command (ALT,C,E)
Once selected the Subtrahend Grid, this command calculated the grid difference as the node-by-node
subtraction of the two given grids. Use the print menu to view the results of the elaboration.
For more information, see the "Grid Difference - Introduction to the ISOMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

34 - ISOMAP & INQUIMAP for Windows - User Guide

Print Menu (ALT,P) - Grid Difference
The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.
For more information, see the "Print Menu - General commands"
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Chapter 12 - ISOMAP Menus - Linear
Transformation
Edit Menu (ALT,E) - Linear Transformations
The linear transformation operator makes it possible to perform a linear transformation of the surface,
performing the following three sequential operations for each node:
1. sums a first translation factor (a);
2. multiplicates by a scale factor (b);
3. sums a second translation factor (c).
The general formula z'=(z+a)*b+c makes it possible to perform any linear transformation such as the CelsiusFahrenheit conversion, with a=0, b=9/5 and c=32.

Hidden Mesh Selection Command (ALT,E,M)
This command allows one to hide some of the grid meshes.
For more information, see the "Hidden Mesh Selection - ISOMAP Menus - Grid Generation"

Linear Transformation Parameters Command (ALT,E,T)
This command enables one to define the parameters for the linear transformation.

The “Linear Transformation Parameters” Dialogue box
In the “Linear Transformation Parameters” dialogue window the following data are required:

•

First translation factor: it is the constant a in the linear transformation z'=(z+a)*b+c formula.
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•

Scale factor: it is the scale factor ‘b’ in the linear transformation formula.

•

Second translation factor: it is the constant 'c' in the linear transformation formula.

Calculate Menu (ALT,C) - Linear Transformation
With this menu, a linear transformation is performed on each node of the source grid.

Execute Calculations Command (ALT,C,E)
With this command, the linear transformation is performed on each node of the source grid, using the given
parameters.
For more information, see the "Linear transformation - Introduction to the ISOMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) - Linear Transformation
The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.
For more information, see the "Print Menu - General commands"
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Chapter 13 - ISOMAP Menus - Filtering
Edit Menu (ALT,E) - Filtering
This operator performs a numerical filtering in the space domain, that is to say, the convolution of a matrix
operator of order 2n+1 with the grid itself.
The filters should always be symmetrical to the axis that passes through its centre, and to the two diagonals.
By using a unit matrix one will obtain a grid that is the moving average of the original grid. By using this
command in conjunction with the Grid Difference operation, one can, for example, separate the local gravity
anomalies from the regional ones.

Hidden Mesh Selection Command (ALT,E,M)
This command allows one to hide some of the grid meshes.
For more information, see the "Hidden Mesh Selection - ISOMAP Menus - Grid Generation"

Select Filter Command (ALT,E,F)
With this command, the program shows the “Select Filter” dialogue box.

The “Select Filter” Dialogue box
To select a file, type the name of the file containing the digital filter to be used for the current operation in the
File Name field, or browse the hard disk and double-click the filter file name.
To create a new digital filter, type a new name and confirm, and then select the command Edit Filter from the
Edit menu.

Edit Filter Command (ALT,E,E)
With this command Notepad is started, and one can create or edit a custom filter.
The structure of the filters is quite simple: the order of the matrix operator is written in the first line. This should
always be an odd number. The coefficients are written in the following lines, separated by spaces.
This is an example of a filter that performs the average of the values along a circle centred on a grid node:
11
.00000 .00000 .00000 .03571 .03571 .03571 .03571 .03571 .00000 .00000 .00000
.00000 .00000 .03571 .00000 .00000 .00000 .00000 .00000 .03571 .00000 .00000
.00000 .03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571 .00000
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
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.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.00000 .03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571 .00000
.00000 .00000 .03571 .00000 .00000 .00000 .00000 .00000 .03571 .00000 .00000
.00000 .00000 .00000 .03571 .03571 .03571 .03571 .03571 .00000 .00000 .00000
The filters can be created with any external word-processor, shoud have the “.FIL” extension and shoud be
saved as plain text.

Calculate Menu (ALT,C) - Filtering
With this menu, the grid filtering is performed.

Execute Calculations Command (ALT,C,E)
With this command, the grid filtering is performed using the chosen filter.
For more information, see the "Filtering - Introduction to the ISOMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) - Filtering
The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.
For more information, see the "Print Menu - General commands"
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Chapter 14 - Introduction to the module
INQUIMAP
Introduction to the module INQUIMAP
Most of the complex problems related to ground-water modelling can be solved with INQUIMAP.
It allows the geometric modelling of the water table and the insertion of one or several wells, flooded areas,
barriers and impermeable barriers, recharge points and variations in permeability.
The obtained surfaces can be directly used to determine safe areas or to identify, in back-analysis terms, the
position of the contamination sources. The calculation can be performed with the finite differences method (this
allows the introduction of recharge areas and points with a fixed or lowered piezometric levels), as well as
trough the superimposition of effects (operating on a unconfined, confined or semi-confined aquifer, in steady or
transient flow conditions).
The program reconstructs the isochronal lines by enveloping the flow lines that reach each well through a
process of time-domain integration. It is thus possible to determine the protection areas around water wells for
domestic use. In order to calculate the iso-concentration lines the programme utilises an analytical-numerical
extension of the well-known dispersion and convection equations used for a plane water table to fit the context
of an uneven water table. This problem can be analysed in terms of steady or continuous flows, following the
development of the contamination in the time-domain. A solution for steady immission is also provided. The
program also allows the flow-analysis through vertical sections.

Finite Differences (INQUIMAP Module)
The numerical recalculation of the equilibrium conditions of an underground aquifer is performed with the finite
differences method. This enables one to take into account all parameters that normally influence the behaviour
of the piezometric surface. It is especially possible to define some areas where the hydraulic potential or flow
capacity are constant and, obviously, to identify zones with different permeability.
The equations that describe the model demand that at each grid node that does not have a constant potential
the flow, is governed by Darcy’s law and its total is zero:

q + ∑ (K *i *A) = 0
q+ ∑ j (Kj * ij *Aj) = 0
where:
q = constant flow
K = reciprocal of the average of the reciprocals of the permeability of the nodes
i = hydraulic gradient
A = variable or constant section with free or confined aquifers
The model is treated by solving with the Gauss-Seidel method one of the two systems present respectively free
or confined aquifers
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The conditions that satisfy fully the formulae shown are the following:
- negligible vertical flow components;
- constant depth of the impermeable base in the whole model;
- vertical homogeneity of the hydrogeological parameters of each mesh;
- constant thickness of the aquifer in the case of a confined aquifer.
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Superimposition of Effects (INQUIMAP Module)
The superimposition of effects operation is a simpler method in respect to the finite elements method. It is
based, as a matter of fact, on the hypothesis that the aquifer, around each well where operations start, is made
of an isotropic and homogenous medium. In a point of the water table, the depressions are due to
superimposition of the effects of al the wells which radius of influence is larger than the distance to the well. This
can be calculated with th following equations, respectively for free and confined aquifers:

H 2 - h 2 = Q / (Kπ ) ln(R / r)
or

H - h = Q / (2 K π E) ln(R / r)

where:
H = height of the undisturbed water table from the impermeable stratum;
h = height of the water table when pumping takes place;
Q = pumping flow;
K = permeability around the well;
R = radius of influence of the well;
r = distance corresponding to height h;
E = thickness of the confined aquifer.
The conditions that satisfy complete the formulae indicated above are the following:
- complet wells;
- homogeneity of the hydrogeological parameters around the each well.

Draw Isochrones (INQUIMAP Module)
The re-construction of the isochrones is obtained by enveloping the flow lines; these are constructed from each
well and extended just to the time interval that characterises the isochrone value.
The problem of the reconstruction of the flow lines is represented by a typical Cauchy problem, that consists of
the reconstruction of continuous functions, continuously derivable from the initial conditions and the first
derivative. The initial conditions are given by the position in time t=0, the coordinates of the well, while the first
derivative, that is to say the velocity, is given by the gradient multiplied with the ratio between permeability and
kinetic porosity.
The problem is solved by Heun’s method, which is part of the Runge-Kutta family of methods and unites a
remarkable speed of calculation to an excellent degree of convergence.
The integration is done on equally spaced points placed on concentric circles around the well for two motives:
1. obtain a more homogeneous covering in all directions, which is a fundamental factor for a complete
reconstruction of the area to be protected;
2. compensates for the fact that the phreatic surface, constructed with bi-cubic splines, is continuous and
continuously derivable in all its points and especially at wells where, as these are minimum points, the
surface is tangent to a horizontal surface and hence renders velocity zero, that on the contrary in these
points, correlated to the physical problem. there is a maximum.

Calculation Concentration (INQUIMAP Module)
The problem of the iso-concentration calculation is resolved with an analytical-numerical method based on a few
simple hypothesis: the presence of an aquifer, thin in respect to the distance the contaminant has travelled; this
causes a nearly instantaneous diffusion along the vertical. The motion and diffusion components are considered
sub-horizontal, without vertical exchanges.
The pollution, assumed to radiate from a point, can be of three types: instantaneous, continuous (when the
pollution extends in time) or stationary (continuous pollution calculated continuing infinitely in time).
The calculation method is based on an analytical calculation for the case of the plane aquifer in a homogeneous
isotropic medium, adapted to the real situation with a geometrical transformation that deforms the originally
parallel flow lines to let them coincide with the real flow lines.
The result is therefore analytically exact when one uses a plane aquifer; it is a good approximation in the case
the aquifer is regular at the well and deformed downhill (typical the case of a drainage well) while the
approximation is poor when at the well location the aquifer is quite disturbed.
When making documentation for a third party we always advise to use the classical approach, amply
documented in literature when performing calculations on a plane aquifer; the procedure to be used to adapt a
real situation is however an experimental procedure, not supported by theoretical documentation in literature.
We advise therefore to use it only to acquire a better understanding of the physics of the problem.
The calculation of the iso-concentrations is performed through numerical integration of the classical equation for
transport and diffusion:

∂c / ∂t = k x ∂ 2 c / ∂x 2 +...+v x ∂c / ∂x+...+s

where:
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c = value of concentration
t = time
k = dispersion coefficient
s = well term
The mechanical dispersion coefficient is taken to be invariable in time and to be anisotropic, inasmuch it is
determined by the product of effective velocity with two terms of dispersion, a longitudinal and a transversal one.
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Chapter 15 - INQUIMAP Menus - Finite
Differences
Edit Menu (ALT,E) - Finite Differences
This menu is used to enter and edit input data used in the operations.

Hidden Mesh Selection Command (ALT,E,M)
This command allows hiding some of the grid meshes.
For more information, see the "Hidden Mesh Selection - ISOMAP Menus - Grid Generation"

Finite Differences Parameters Command (ALT,E,F)
Here the parameters are defined for the recalculation of the surface with the finite differences method.

The “Finite differences parameters” Dialogue Box
In “Finite differences parameters” dialogue windows the following data have to be entered:

•

Number of iterations: it is the number of calculations one retains as necessary in order to attain a state of
equilibrium. As it is not possible to deduce a relation between time and number of iterations, one can not
take a reduced number of iterations to simulate a condition of non-stationary flow. We suggest a number of
iterations varying from 10 to 20 times the number of meshes that make up the perimeter of the grid,
according to the degree of perturbation induced by the new conditioning of the problem.
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•

Minimum error: at present this field is not used.

•

Level of aquifer bed: this parameter should only be used for free aquifers, as in this case the flow section
used by the calculation is dependent from both the water table height as from the depth of the impermeable
bed. The depth of the bed has, however, no influence on confined aquifers, as the flow quantities do not
depend on the height of the water table from the impermeable bed but from the hydraulic gradient. The
calculation assumes an aquifer lying on a horizontal plane placed at the depth indicated in this field.

•

Aquifer thickness: when one is considering a free aquifer the thickness should be zero. When the thickness
if larger than zero the program will consider the aquifer as confined and will use the apposite calculation
formulae.

Define Permeability Command (ALT,E,P)
With this command the grid, used to define the permeabilities of the different zones, will be drawn on-screen.
When there are large discontinuities in permeabilities, like in the case of impermeable barriers, it is best to use
mesh sizes as small as to represent the barrier at least two meshes thick. Otherwise there might be, on the
border between areas with different values, small defects in the graphical representation due to the attempt to
render continuous the surface.
The meshes that had permeability values assigned to them are shown in a different colour for each permeability
value. By moving the mouse the permeability value of that mesh is shown in the Value field.
Let us see how to associate a permeability value to a mesh. On the right hand side of the screen one can see
the commands for this window:
•

<Value to enter>: click in this field and enter permeability, hence press ENTER. The value entered will be
rewritten with the colours that characterises the area to which it will be associated. To assign values to the
mesh there are three methods: click with the left button and assign the value to the single mesh; by dragging
the mouse the value will assigned to all the meshes traversed; clicking with the right button will assign the
value to all zones with homogeneous conditions.

•

<Cancel edit>: cancels the last edit operation.

•

<Save>: saves the data entered or edited and passes on to the next phase.

•

<Cancel>: closes the window without saving the data or executing the command.

Define Boundary Conditions Command (ALT,E,B)
With this command one can select the type of conditioning for the model. With the expression conditioning of the
model we mean the set of operations necessary to define the conditions that have to be satisfied in the
hydrodynamic re-equilibration phase of the model.
The calculation procedures tend to reconstruct the geometry of the water table surface in such a way as to
respect the equilibrium conditions, that is to say in accordance with Darcy’s law. Therefore the flow through a
determined section is proportional to the permeability gradient, and the total flow in a node should be zero
(taking also into account flow due to water removal).
It is clear therefore that in order to obtain a reliable result it is necessary to define the boundary conditions, at
such a distance from the structures as not to be influenced by these. To do so one can use the Initial Values
option that assigns to a set of nodes of the grid the initial value in the initial project that is to say with the values
the water table had before eventual water removal.
It is clear that the set of notes should perforce contain the whole border (or in some cases only a part in the
case when a part of the border is made up of impermeable materials, and these parts should be defined as
such). The program puts, as already selected with initial values the nodes at the border of the grid. It is however
possible to define as initial values, some internal point, typically the lowest levels of the water table, when one
knows that these minima are due to pumping which is in operation at the moment of the measurement of the
water table. These points should be indicated in some way to the model, and if the natural water table can not
be reconstructed without any pumping operation, it is at least necessary to indicate it’s presence with this option.
In all cases the nodes characterised by the Initial values are considered as nodes with a constant potential, and
their values will not be modified when the model is re-equilibrated.
Similar to those just described are the cases of Constrained Lowering, whose constant potential is assigned to
the meshes selected, where their value will be the measured value diminished by a constant. Similarly the
Constrained Level will have a value given by the operator. Also the in the latter two cases
their values will not be modified when the model is re-equilibrated.
It is important to note that it can be advisable to perform a first phase of re-equilibration of the model taking into
account only the initial values and hence impose only in a second moment the constrained lowering and
constrained levels, this because the level of hydrodynamic equilibrium does not necessarily coincide with the
extrapolated value when the project was started, and thus the constrained lowering coincide in these two cases
with a negative influence on the flows.
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This is obviously not the case when the constrained level is a level that coincides with the topographical surface,
for example when one wants to lower the water level to below a quarry floor; in that case it is clear that the water
level should be at that determined height, apart from the amount of water that should be pumped to obtain that
result.
In the case of pre-determined flow (positive for removal of water) the value influences on the total balance of the
flows at the nodes and the value resulting from the re-equilibration is no longer influenced by the initial value: in
this case therefore it is no longer necessary to intervene on an aquifer equilibrated beforehand. Please note that
in the case of pre-determined flow, often the lowering of the conditions of equilibrium in the corresponding
nodes is often strongly underestimated (and only partially nearby); this is due to the fact that it is not possible to
explicitly size the radius of the well, therefore the well radius is implicitly set to correspond to about one mesh
size. For the same reason, in case of constrained lowering, the global lowering of the aquifer is overestimated
(while a lowering is only correct at the well). From this one can deduce that to have a correct result, both at a
large or small scale, it can be a good idea to perform the calculation by using pre-determined flows and thus in a
second phase assign the effective amount of lowering of the level in the well (calculated in respect to the reequilibrated water table without wells), indicating as nodes with constant initial potential the eight nodes around
it. In this way the lowering of the water table can not be extended to the whole aquifer, and the lowering is only
obtained at the well. This procedure is particularly useful when one wants to calculate isochrones, as a flattened
water table near the well tends to generate reduced isochrones in comparison with reality.
With the Recalculable option one can liberate the selected meshes from previous constraints.
The meshes, to which a conditioning was applied previously, are shown with a different colour for each type of
conditioning and value.
By moving the mouse on the grid, the conditioning and the value of the current mesh is shown in the field, below
the coordinates. Let us see how these conditionings can be defined. The commands for this window are placed
on the right hand of the screen.
•

Conditioning Table: select from this table the type of conditioning to assign to the meshes by clicking on it.
Define in the field “Value to enter” to be associated to the meshes and press the ENTER key. This procedure
is, obviously, not necessary when one selects Initial values, as the program knows the initial value of each
mesh, it is sufficient to click on Initial values and select the meshes that can not be modified during
calculation. To assign a conditioning to the meshes of the grid there are three methods: by clicking on the
left button the conditioning is assigned to this single mesh; by dragging the mouse the conditioning,
previously assigned, is extended to all meshes traversed by the mouse; by clicking the right button the
conditioning, previously assigned, is extended to all areas having a homogeneous condition.

•

<Value to enter>: after selecting the type of conditioning click in this field and enter the value to be given to
the meshes and press ENTER. The value entered is written in the colour that will characterise this value in
the grid drawing. To assign a conditioning to the meshes of the grid there are three methods: by clicking on
the left button the conditioning is assigned to this single mesh; by dragging the mouse the conditioning,
previously assigned, is extended to all meshes traversed by the mouse; by clicking the right button the
conditioning, previously assigned is, extended to all areas having a homogeneous condition..

•

<Cancel edit>: cancels the last edit operation.

•

<Save: Saves the data entered and edited and passed on to the next phase.

•

<Cancel>: Closes the window without saving the data and without executing the command.

As said before, normally only the nodes on the border of the grid have fixed initial conditions. This procedure
tends, however, to eliminate the areas of variability within the grid, forcing the water table to its regional trend.
This is a useful procedure when one has little information on the real form of the aquifer.
Contrariwise, when information is plentiful and enhance areas of variability the procedure, to be used to
recalculate the surface so as to be congruent with reality, becomes more complex.
First of all the cause why the phreatic surface assumes a certain form should be understood. This can depend
on lateral variations of permeability or the presence of pre-existing wells. In the first case it is preferable to set
as fixed nodes those that are on the grid edge, or on two opposing sides only, whenever conditions require it,
trying to make the water table converge to its natural condition by using lateral variation of permeability. In case
the local form of the aquifer surface is determined by wells that were activated in the past it is preferable to
define as fixed both the nodes at the grid edge as well as the nodes, or zone, near to these wells.
Thus, it should be clear by now why the correct definition of local variability of the aquifer is important. Fixing a
node to make sure that the re-calculation does not force the water table to its regional trend, when that local
trend depends from the underground geometry and not from a well. This will have as effect that during the recalculation phase, to define the new water level due to other wells entering production, this level is forced to a
height that does no long represent the true height.
It is a good idea to perform a cycle of iterations to equilibrate the water table before simulating the placement of
new wells to distinguish the effects of deformation of the phreatic surface due to re-calculation from that of the
new wells. With, for example, three calculations that represent the measured water table, the water table reequilibrated through finite differences and the water table after the new wells have gone on stream.
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Calculate Menu (ALT,C) - Finite Differences
With this menu one can calculate the surface.

Execute Calculations Command (ALT,C,E)
With this command, the calculation is performed.
For more information, see the "Finite Differences - Introduction to the INQUIMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) – Finite Differences
The Print menu is used for configuring the graphic output and for plotting the surface in form of Map, Wireframe
View, or Solid View.
For more information, see the "Print Menu - General commands"
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Chapter 16 - INQUIMAP Menus Superimposition of Effects
Edit Menu (ALT,E) - Superimposition of Effects
This menu is used to enter and edit input data used in the operations.

Hidden Mesh Selection Command (ALT,E,M)
This command allows hiding some of the grid meshes.
For more information, see the "Hidden Mesh Selection - ISOMAP Menus - Grid Generation"

Wells for Superimposition of Effects Command (ALT,E,W)
With this command one can position a producing well on the surface of the water table calculated previously
(original project).

The “Aquifer type” Dialogue Box
The “Aquifer type” dialogue window enables one to select the type of aquifer where the producing wells are
installed; apart from the aquifer, different parameters will be required to describe the area and the wells.

The program considers three different types of aquifers: free, semi-free and confined. Confined aquifers can be
treated with the method by Jacob for stationary flow or the method by Theis with transient flow. Note that apart
from the type of aquifer selected the well is considered to be complete with the completion bottom in the
impermeable stratum.
Please note that it is preferable, that when on this project the Draw Isochrones operation should be performed,
that the wells will be located exactly on a grid node, as these are the points analytically determined by the
calculation. In case the well, or the minimum point, does not coincide with a node one will have a loss of
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resolution in the calculation as it will be approximated according to the trend of the water table in the
surrounding nodes, with a an error that increases with the increase of the ratio between the mesh width and the
radius of influence of the well.

Free aquifers
In the case of a free aquifer the well is considered to have an open completion throughout the aquifer’s
thickness.
The “Select wells” dialogue window has the following five buttons:
<New>: by clicking on this button the window to enter the well’s characteristics is shown:

•

Well name: this is an optional information to give the user a quick identification of the well.

•

Abscissa: the abscissa, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Ordinate: the ordinate, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Thickness of undisturbed aquifer: as the formulae for the re-calculation of the cone of influence presupposes
that the well bottom is completed in the impermeable sub-stratum it is necessary to enter the Thickness of
the undisturbed aquifer, this is before the well went on stream. It should be expressed in meters.

•

Flow: the flow should be expressed as cubic metres per second.

•

Permeability: the formulae used presume the existence of homogeneous and isotropic medium in the area
covered by the cone of influence. Here one has to enter the average local permeability around the well.
Please note that with the superimposition of the effects, the discrete differences in permeability are ignored.

•

Well radius: This is important to determine the effective depression of the water in the well. It should be
expressed in metres.

•

Radius of influence: it is the radius of maximum extension of the cone of influence; it is derived from
pumping tests.
When one confirms the data one is returned to the “Select wells” window, wherein the data pertaining to the well
shall be entered.
•

<Modify>: by selecting one of the wells, defined previously, and clicking on this button the window showing
the data of the well is shown so one can edit these.

•

<Delete>: deletes the information of the selected well.

•

<Ok>: saves the data that were entered and closes the window.

•

<Cancel>: closes the window without saving the data.
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Semi-confined aquifer
In the case of a semi-confined aquifer the well is considered to have an open completion but only in the semiconfined part of the aquifer. The flow components, through the semi-impermeable layer, are assumed to be
vertical only.
The “Well selection” dialogue window has the five buttons:
<New>: by clicking on this button the following window is shown where the characteristics of the well are
entered:

•

Well name: this is an optional information to give the user a quick identification of the well.

•

Abscissa: the abscissa, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Ordinate: the ordinate, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Total thickness of aquifer: expressed in metres. It is the sum of the thickness of the confined aquifer and the
semi-impermeable layer, plus the distance from the free undisturbed water table to the top of the semiimpermeable bed.

•

Flow: the flow should be expressed as cubic metres per second.

•

Thickness of confined aquifer: expressed in metres. One assumes that this value is constant around the well
and the horizontal stratification. The indicated thickness will also be used for the height of the part of the well
where an open completion is present.

•

Permeability of confined aquifer: the formulae we used assume the presence of a homogeneous and
isotropic medium for the whole extension of the cone of influence. Here one has to enter the average local
permeability around the well. Please note that with the superimposition of the effects the discrete differences
in permeability are ignored. Because of the presence of the impermeable layer it is not possible to determine
transmissivity directly, hence thickness and permeability should be entered explicitly.

•

Thickness of semi-impermeabile layer: to be expressed in metres. The flow through the semi-impermeable
layer is supposed to be sub-horizontal.

•

Permeability of semi-impermeable layer: the formulae we used assume the presence of a homogeneous
and isotropic medium for the whole extension of the cone of influence. Here one has to enter the average
local permeability around the well. Please note that with the superimposition of the effects, the discrete
differences in permeability are ignored. The permeability of the free aquifer part will be taken as to be higher
than that of the semi-impermeable layer so that the geometry of the upper aquifer will not be influenced by
water production.
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•

Duration of water production: the duration of the water production should be expressed in seconds.

•

Coefficient of storativity: please remember that the coefficient of storativity, the kinetic porosity and the
effective porosity have approximately the same value in a free aquifer; these values can differ several orders
of magnitude for confined and semi-confined aquifers. The coefficient of storativity is referred to the deep,
semi-confined aquifer.
When one has confirmed the input, one returns to the “Select wells” window where the characteristics of each
well are entered.
•

<Modify>: by selecting one of the wells, defined previously, and clicking on this button the window showing
the data of the well is shown, so one can edit these.

•

<Delete>: deletes the information of the selected well.

•

<Ok>: saves the data that were entered and closes the window.

•

<Cancel>: closes the window without saving the data.

Confined aquifer (stationary flow - Jacob method)
The “Well selection” dialogue window has the five buttons:
<New>: by clicking on this button the following window is shown where the characteristics of the well are
entered:

•

Well name: this is an optional information to give the user a quick identification of the well.

•

Abscissa: the abscissa, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Ordinate: the ordinate, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Flow: the flow should be expressed as cubic metres per second.

•

Transmissivity: one assumes that this value is constant around the well and the horizontal stratification.
Here one has to enter the average local permeability around the well. Please note that with the
superimposition of the effects, the discrete differences in permeability are ignored.

•

Well radius: should be expressed in metres.

•

Radius of influence: it is the radius of maximum extension of the cone of influence; it is derived from
pumping tests.
When one confirms the data one is returned to the “Select wells” window, wherein the data pertaining to the well
shall be entered.
•

<Modify>: by selecting one of the wells, defined previously, and clicking on this button the window showing
the data of the well is shown so one can edit these.

•

<Delete>: deletes the information of the selected well.
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•

<Ok>: saves the data that were entered and closes the window.

•

<Cancel>: closes the window without saving the data.

Confined aquifer (transitory flow - Theis method)
The “Well selection” dialogue window has the five buttons:
<New>: by clicking on this button the following window is shown where the characteristics of the well are
entered:

•

Well name: this is an optional information to give the user a quick identification of the well.

•

Abscissa: the abscissa, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Ordinate: the ordinate, expressed in meters, of the planimetric position of the well in the same coordinate
system used to construct the grid; it is mandatory that the well coordinates correspond to a grid node
coordinate.

•

Transmissivity: the formulae we used assume the presence of a homogeneous and isotropic medium for the
whole extension of the cone of influence. Here one has to enter the average local permeability around the
well. Please note that with the superimposition of the effects the discrete differences in permeability are
ignored.

•

Flow: should be expressed in cubic metres per second

•

Duration of water production: the duration of the water production should be expressed in seconds.

•

Coefficient of storativity: please remember that the coefficient of storativity, the kinetic porosity and the
effective porosity have approximately the same value in a free aquifer; these values can differ several orders
of magnitude for confined and semi-confined aquifers. The coefficient of storativity is referred to the deep,
semi-confined aquifer.
One has confirmed the input one returns to the “Select wells” window, where the characteristics of each well are
entered.
•

<Modify>: by selecting one of the wells, defined previously, and clicking on this button the window showing
the data of the well is shown so one can edit these.

•

<Delete>: deletes the information of the selected well.

•

<Ok>: saves the data that were entered and closes the window.

•

<Cancel>: closes the window without saving the data.

Calculate Menu (ALT,C) - Superimposition Effects
With this menu one can calculate the surface.
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Execute Calculations Command (ALT,C,E)
With this command, the calculation is performed.
For more information, see the "Superimposition of Effects - Introduction to the INQUIMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) – Superimposition Effects
The Print menu is used for configuring the graphic output and for plotting the surface in form of Map, Wireframe
View, or Solid View.
For more information, see the "Print Menu - General commands"
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Chapter 17 - INQUIMAP Menus - Trace
Isochrones
Edit Menu (ALT,E) - Trace Isochrones
This menu is used to enter and edit input data used in the basic operations.

Hidden Mesh Selection Command (ALT,E,M)
This command allows hiding some of the grid meshes.
For more information, see the "Hidden Mesh Selection - ISOMAP Menus - Grid Generation"

Define Permeability Command (ALT,E,P)
With this command the grid, used to define the permeabilities of the different zones, will be drawn on-screen.
For more information, see the "Define Permeability Command - INQUIMAP Menu – Finite Differences"

Position Isochrones Wells Command (ALT,E,O)
With this command the positions of the wells on the grid are defined. It is absolutely necessary that the well
positions coincide with the grid nodes that approximate as much as possible the real position.
Whenever the well is not positioned on a node, the program automatically moves the well’s position to the
nearest node coordinates.
If the well’s position does not match a minimum point the program will trace isochrones uphill.

The "Positioning of wells" Dialog Box
In “Positioning of wells” dialogue windows the following data have to be entered:
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•

X Coord.: abscissa of wells from the arbitrary origin used.

•

Y Coord.: ordinate of wells from the arbitrary origin used.

Isochrone Calculation Parameters Command (ALT,E,I)
With this command one can define the parameters for the calculation of the isochrones.

The “Isochrone Calculation Parameters” Dialogue Box
In the “Isochrone Calculation Parameters” dialogue window one has to enter the following data:

•

Initial circle radius: the starting points of the isochrones lie on nodes defined as the position of the wells
through the command of this menu. This parameter is necessary to start the flow lines along the directions
of maximum dip of the aquifer, possibly equally spaced. This hypothesis is necessary as the surface, that is
continuously derivable around the wells-nodes is horizontal here with a velocity about zero. Leaving the
radius of starting circle equal to zero it is possible to make the program draw isochrones uphill; to calculate
downhill one should define a negative kinetic porosity value. It is mandatory that the starting point does not
coincide with a well.
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•

Kinetic porosity: the kinetic porosity is a non-dimensional parameter comprised between 0 and 1 that
represents the ratio between the mean effective flow and the speed according to Darcy, approximately
equivalent to effective porosity; the latter represents the ratio between volume of water in an aquifer and the
total amount of water in the sample. The kinetic porosity is a quite important parameter as the effective flow
velocity is inversely proportional to it, according to the formula v=ki/e, where "v" is the velocity, "k"
permeability and "e" the kinetic porosity.

•

Isochrone value: up to four time values are allowed (expressed in seconds) to trace the isochrones and/or
flow lines. The two values proposed by the program are (in seconds) respectively equal to 30 and 60 days.

Calculate Menu (ALT,C) - Trace Isochrones
With this menu one can calculate the surface.

Execute Calculations Command (ALT,C,E)
With this command the program executes the isochrones calculation.
For more information, see the "Trace Isochones - Introduction to the INQUIMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) - Trace Isochrones
The Print menu is used for configuring the graphic output and for plotting the surface in form of Map, Wireframe
View, or Solid View.
For more information, see the "Print Menu - General commands"
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Chapter 18 - INQUIMAP Menus - Calculation
Concentrations
Edit Menu (ALT,E) - Calculation Concentrations
This menu is used to enter and edit input data used in the operations.

Hidden Mesh Selection Command (ALT,E,M)
This command allows hiding some of the grid meshes.
For more information, see the "Hidden Mesh Selection - ISOMAP Menus - Grid Generation"

Define Permeability Command (ALT,E,P)
With this command the grid, used to define the permeabilities of the different zones, will be drawn on-screen.
For more information, see the "Define Permeability Command - INQUIMAP Menu – Finite Differences"

Concentrations Calculation Command (ALT,E,C)
With this command one can define the parameters necessary to calculate the iso-concentration curves.

The “Iso-concentration parameters” Dialogue Box
In the “Iso-concentration parameters” dialogue window the following data must be entered:

•

Type of immission: three different types of pollutant immission have been foreseen. Instantaneous pollution:

57 - ISOMAP & INQUIMAP for Windows - User Guide

the hypothesis of perfect miscibility of the pollutant in case of an instantaneous pollution considers an
aquifer of reduced thickness in respect to the horizontal extent, wherein the vertical dilution of the
contaminant is practically immediate and thus would be equally concentrated for each metre of aquifer
thickness; the motion and diffusion components are considered to be sub-horizontal, without vertical
exchanges and therefore the pollutant flow should be expressed in grams/metre. Instantaneous Pollution:
This is to be used when the pollution is prolonged in time. The program calculates the situation at different,
sequential, times. Stationary pollution: continuous pollution calculated as to last into infinity.
•

Abscissa and ordinate of a polluting well: the use of only one polluting well is contemplated. It is possible to
make a superimposition of the effects of more calculations, calculated at the same time T with different
points and starts of pollution.

•

Flow pollutant: the flow should be defined in grams/second/metre in the case of a continuous or stationary
pollution, for instantaneous pollution it should be in gram/metre.

•

Kinetic porosity: the kinetic porosity is a non-dimensional parameter comprised between 0 and 1 that
represents the ratio between the mean effective flow and the speed according to Darcy, approximately
equivalent to effective porosity; the latter represents the ratio between volume of water in an aquifer and the
total amount of water in the sample. The kinetic porosity is a quite important parameter as the effective flow
velocity is inversely proportional to it, according to the formula v=ki/e, where "v" is the velocity, "k"
permeability and "e" the kinetic porosity.

•

Longitudinal dispersion: the value is the ratio between the diffusion coefficient and the effective velocity. It is
normally isotropic in respect to the direction of movement

•

Lateral dispersion: the value is the ratio between the diffusion coefficient and the effective velocity. It is
normally anisotropic in respect to the direction of movement

•

Immission duration: duration, in days, of the pollutant. This parameter is used obviously only in case of
instantaneous pollution or continuous pollution, while it is ignored in the case of stationary pollution.

Calculate Menu (ALT,C) - Calculation Concentrations
With this menu one can calculate the surface.

Execute Calculations Command (ALT,C,E)
With this command the program executes the iso-concentration calculation.
For more information, see the "Calculation Concentrations - Introduction to the INQUIMAP module"

Z(X,Y) Calculation Command (ALT,C,C)
With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the "Z(X,Y) Calculation" - ISOMAP Menus - Grid Generation

Print Menu (ALT,P) - Calculation Concentrations
The Print menu is used for configuring the graphic output and for plotting the surface in form of Map, Wireframe
View, or Solid View.
For more information, see the "Print Menu - General commands"

